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Excel® 2007
Spreadsheets made simple.

The newest version of Microsoft’s spreadsheet software, Excel 2007, combines 

all the long-standing features of Excel with powerful new capabilities. Whether 

you’re entirely new to Excel or simply upgrading, discover how to:

Navigate the new and improved Excel 2007 interface with fluency

Create, format, sort, and print spreadsheets and workbooks

Insert formulas, functions, charts, graphs, and more 
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The Excel 2007 Interface
Microsoft Excel® 2007 is a spreadsheet program designed 
for computers that run on the Microsoft Windows® operat-
ing system. Along with the other programs in the Microsoft 
Office® 2007 Suite, the 2007 version of Excel has been 
significantly revamped. With this program, Microsoft has 
made the user interface more powerful yet simpler to use. 
The Excel 2007 interface has four basic parts:

Office button
Ribbon
Quick Access Toolbar
Help button

The Office Button
The Office button is a round button with the Microsoft  
Office® insignia on it. Clicking it reveals commands that 
resided in the File menu in earlier versions of Excel.

The Ribbon
The Ribbon is the core of the new Excel interface. It replac-
es the drop-down menus and toolbars of previous versions 
of Excel and organizes and displays the myriad functions 
that Excel provides more effectively than the old menus or 
toolbars did. The Ribbon makes it easier for you to find and 
use the commands you need in order to work with your 
spreadsheets. The Ribbon is made up of tabs and groups.

Tabs 
Tabs are the main organizational categories for Excel com-
mands. When you click on a tab, the commands within that 
tab appear on the Ribbon. Excel 2007 has seven main tabs: 
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Home: These are the most commonly used Excel 
commands. 
Insert: These commands are used to insert elements 
such as graphs and charts into your spreadsheet. 
Page Layout: These commands control the visual 
presentation of your spreadsheet.
Formulas: These commands add to your spreadsheet 
specialized formulas that perform particular functions.
Data: These commands are for sorting, summarizing, 
or otherwise working with data in your spreadsheet. 
Review: These commands are for collaborating, 
proofing, and protecting a spreadsheet from tampering.
View: These commands change how you can view 
your spreadsheet on the screen, as well as hide or 
show particular tools you may or may not want to use.

Groups
The commands displayed within each tab are further orga-
nized into smaller groups. For instance, the Home tab has 
the groups Clipboard, Font, Alignment, Number, Styles, 
Cells, and Editing. Some groups also have a little square at 
their bottom right, called a dialog box launcher (or launcher 
for short). Clicking the launcher pops up a dialog box that 
provides more tools in the category that the group covers.

Quick Access Toolbar
The Quick Access Toolbar spans the top of the Excel win-
dow and contains the commands you use most often, such 
as Save, Undo, and Redo. It’s visible no matter which tab 
you’ve selected. You can customize the commands that 
appear on the toolbar by selecting a command from the 
menu that appears when you click on the down arrow  at 
the toolbar’s right. 
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Help
You can access Excel’s built-in help system through the 
Help button  or by be pressing F1 on your keyboard.

The Excel Work Area
Though the interface has been overhauled, the Excel 2007 
work area looks and works much the same as in previous 
versions of Excel. The work area has three main parts:

Spreadsheet: This grid of columns (labeled by letter or 
letter combination, starting with A) and rows (labeled 
by number, starting with 1) displays the spreadsheet 
you’re currently working on. 
Name box: This lists the current active cell by column 
and row letter. If the top left cell is the active cell, A1 
will appear in the Name box.
Formula bar: This lists the contents of the active cell, 
whether text, a number, an equation, or a formula.

Keyboard Shortcuts in Excel 2007
Keyboard shortcuts are combinations of keystrokes that let 
you execute commands more quickly than with a mouse. 
Keyboard shortcuts from previous versions of Excel, such as 
Ctrl+S to save and Ctrl+B to bold, also work in Excel 2007.
 This guide includes the Excel keyboard shortcuts associ-
ated with any commands covered in the guide, but it does 
not cover all of the hundreds of keyboard shortcuts that are 
possible in Excel. For an organized quick reference of all of 
the keyboard shortcuts in Excel 2007, see the Quamut guide 
to Excel 2007: Keyboard Shortcuts, available in Barnes & 
Noble bookstores and online at www.quamut.com.

How To Customize Keyboard Shortcuts
You can create new shortcuts or modify existing shortcuts 
by recording actions as a macro. To record a macro:

Click the Record Macro icon  located at the bottom 
left of the Excel window.
The Record Macro dialog box opens. Give the macro a 
name and assign it a shortcut key. The “Store Macro in” 
field should say Personal Macro Workbook. Click OK.
Go to the View tab. At the far right, click the Macro 
drop-down and select Use Relative References.
Do the action for which you’d like to make a shortcut.
Click the Stop Record button  at the bottom left of 
the main Excel window.
To use the macro, press the shortcut key you assigned 
to it in step 2.
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How to Control Excel Using the Keyboard
Along with keyboard shortcuts, Excel 2007 provides a key-
board system for executing most Excel commands. This 
system is based on the Alt key. Press the key and little letters 
and numbers appear next to the various tabs or commands 
on the screen. Hit the appropriate key (or keys) to use the 
marked command. For instance, to get to the Ribbon’s Home 
tab, you’d type Alt+H. Once there, a new set of letters and 
numbers appears that marks the Home tab commands. Hit 
those keys to enact those commands. To make the shortcut 
numbers and letters disappear, hit the Alt key again.
 Alt-key commands can involve anywhere from two to 
five keystrokes and may overlap with traditional keyboard 
shortcuts. For instance, you can save an Excel file using 
Ctrl+S or Alt+F, S.

How to Create New Spreadsheets 
and Open Existing Spreadsheets
To get started working in Excel, you first have to know how 
to create a new spreadsheet or open an existing one.

How to Create A New Excel Spreadsheet
You can create an Excel spreadsheet from:

A blank spreadsheet
A template
An existing spreadsheet

How to Create a Blank Spreadsheet
Creating a new spreadsheet in Excel is as simple as launch-
ing the program. When Excel starts, it automatically displays 
a blank spreadsheet. If Excel is already running and you’d 
like to open a new blank spreadsheet: 

Click the Office button and select New (Ctrl+N).
The New Workbook dialog box opens. Select Blank and 
Recent from the left pane of the dialog box.
Select Blank Workbook and click Create.

How to Create a Document from a Template
If you don’t want to build a spreadsheet yourself, you can 
use one of a wide variety of predesigned templates that 
have the appropriate formulas built into them. For instance, 
rather than use Excel to make an invoice from scratch, you 
may be able to use or modify an existing invoice template, 
resulting in less work and a more professional look. Just 
load a template that fits your needs and type right into it.

Click the Office button and select New (Ctrl+N).
The New Workbook dialog box opens. On the left side 
of the dialog box is a list of template categories. The 
category Installed Templates at the top of the list 
contains templates that are automatically installed 
on your computer when you install Excel. The other 
categories contain templates that you can download 
from www.microsoft.com for free. When you select 
a template category, thumbnails of the available 
templates appear in the center pane of the window. 
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When you select a thumbnail in the center pane, a 
larger preview appears on the right side of the window.
Select the template and click Create for an installed 
template or Download for a not-yet-installed template.

How to Create a Document from an Existing Document
This option allows you to treat a document you’ve already 
created as a template: Excel creates a copy of the spread-
sheet you select, and you just type over the text and data 
that’s currently there.

Click the Office button and select New (or Alt+F, N).
The New Document dialog box opens. Select New from 
Existing.
The New Document dialog box now allows you to 
browse for the existing document.
Once you’ve found the document, click Create New.

How to Open an Existing File
To work on a file you’ve already created and saved:

Click the Office button and select Open (Ctrl+O).
The Open dialog box opens. Browse for the file.
Once you’ve found the file, double-click to open it, or 
select it and click Open at the bottom of the dialog box.

Compatibility with Older Excel Files
Excel 2007 can open any Excel spreadsheet created in older 
versions of Excel.

How to Save and Close an Excel 
Spreadsheet
Though Excel 2007 is less prone to crashes than previous 
versions, it’s still a good idea to save your work often.

How to Save Your Excel Spreadsheets
You can save your work in Excel using one of two com-
mands: Save or Save As.

Save: This command saves an existing file under the 
same name. Open the Save As dialog box (see below) 
for a file you haven’t yet saved. Access the Save 
command through the Office button menu, the Save 
icon on the Quick Access Toolbar  or using the 
keyboard shortcut Ctrl+S. 
Save As: This command allows you to save an existing 
file under a new name while preserving the original file 
under the old name. For example, you can use Save 
As to save different drafts of a spreadsheet you’re 
creating. Access the Save As command through the 
Office button menu. A Save As dialog box will appear; it 
will allow you to give the file a name, choose a folder to 
house the file, and select a file type (explained below).

File Types in Excel 2007
As opposed to the .xls files produced by old Excel versions, 
Excel 2007 saves files as either .xlsx, .xlsb, or .xlsm files.
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.xlsx: This is the default file type used by Excel to save 
a regular-sized document that does not contain macros 
(programming code included in an Excel file).
.xlsb: Similar to .xlsx in that it doesn’t allow macros, this 
file type is designed for saving very large spreadsheets.
.xlsm: This is the file type used by Excel to save 
documents that do contain macros.

Microsoft made this change in part to stop hackers from ex-
ploiting macros to spread malicious software. If you receive 
a .xlsx or .xslb file, you can feel comfortable opening it—but 
be suspicious of .xlsm files from unknown sources.

Compatibility and Excel’s New File Types
Older versions of Excel can’t open .xlsx, .xlsb, or .xlsm files. 
To save files compatible with older versions of Excel, use the 
Excel 97–2003 file type. When you save a file in this format, 
Excel also runs a check to make sure that your spreadsheet 
doesn’t contain any formulas or other items that previous 
Excel versions don’t support.

How to Close a Spreadsheet in Excel 2007
To close a spreadsheet, choose Close from the Office but-
ton menu or press Ctrl+W.

How to Navigate an Excel 2007 
Spreadsheet
To work effectively in Excel, it’s helpful to know how to navi-
gate around the Excel work space. You can navigate around 
a spreadsheet in two main ways: 

Scroll by moving the right and bottom scrollbars with 
your mouse.
Use keyboard commands to move the active cell 
around the spreadsheet.

To move . . . Press . . .

Down one cell Enter

One cell to the right Tab

One cell up, down, left, or right Arrow Keys 

To the edge of the data region Ctrl+Arrow Key

To column A in the current view Home

To cell A1 Ctrl+Home

To the last cell in the 
spreadsheet containing data 
or text

Ctrl+End

Up one screen Page Up

Down one screen Page Down

Left one screen Alt+Page Up

Right one screen Alt+Page Down

You can also move to a specific cell in a spreadsheet by typ-
ing the cell’s column and row number into the Name Box.

•

•

•

•

•



Microsoft Excel 2007

How to Navigate Between Spreadsheets
An Excel document is also called a workbook because it 
contains more than one spreadsheet. You can navigate 
between different spreadsheets in a workbook by using the 
spreadsheet tabs at the bottom left of the Excel window.

To move from one spreadsheet in a workbook to the next, 
just click on the spreadsheets tab.

Other Uses for the Spreadsheet Tabs
In addition to navigation, you can use the spreadsheet tabs 
to perform a number of other actions:

Rename a spreadsheet: Either double-click the tab or 
right-click the tab and then choose Rename from the 
shortcut menu. 
Insert a new spreadsheet: Click the New 
Spreadsheet tab  or double-click a tab and 
choose Insert from the shortcut menu. The new 
Spreadsheet tab will appear to the left of the tab  
that you right-clicked.
Delete a spreadsheet: Right-click the Sheet tab and 
choose Delete. When you delete a spreadsheet, all 
data (if any) in that spreadsheet is lost. 
Rearrange the order of a spreadsheet: You can 
reorder the tabs by clicking and dragging them. 
Move or copy a spreadsheet: Right-click the tab and 
choose Move or Copy. You can choose to move the 
tab within the existing workbook or to another open 
workbook. To copy rather than move the tab, click the 
Create a Copy box in the Move or Copy dialog box.

How to Zoom in Excel
Because Excel spreadsheets can get very large, it’s helpful 
to be able to zoom in on a particular area of the spreadsheet 
to do detailed work or zoom out to get a better sense of the 
big picture. Excel gives you two ways to zoom: the zoom 
group and the zoom slider.

Zoom group: You can 
use the buttons on the 
zoom tab to zoom in 
on selected cells, zoom 
to a 100% view of the 
spreadsheet (the size it 
will be when printed), or 
click on the magnifying glass to open the zoom dialog 
box, which has more zooming options.
Zoom slider: This is 
a sliding bar located 
at the bottom right of the Excel window. Click on the 
“+” or “–” or drag the slider to zoom in or out. 

Basic Cell Operations in Excel
A cell is the intersection of a particular row and column on 
an Excel spreadsheet. Each cell has a unique cell address, 
composed of the column letter and row number. At least 
one cell in the spreadsheet is always selected, or active; 
this cell is indicated by a thick border called the cell pointer. 
For instance, in the image below, the active cell is B3.

A group of selected cells is called a range. To refer to a 
range in Excel, you need to use a particular syntax: write the 
first cell in the range, then a colon, then the last cell in the 
range. A range can cover just one column or row, or multiple 
columns or rows. For instance, the range A10:A15 includes 
cells A10, A11, A12, A13, A14, and A15, whereas the range 
A10:B12 includes the cells A10, A11, A12, B10, B11, and B12. 
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How to Select Cells and Ranges
There are several ways to select a cell or group of cells in 
a spreadsheet:

To select a cell: Click the cell or use the arrow keys on 
the keyboard to move the cell pointer to the cell.
To select a range of cells: Click and hold on the first 
cell in the range, then drag over the cells you’d like to 
select in the range.
To select noncontiguous cells or ranges: Select the 
first cell or range, then hold Ctrl while selecting others.
To select all the cells in a column or row: Click the 
heading button. The heading button is the letter label 
for the column or number label for the row reside.

To select multiple rows or columns: Click and drag 
across the headings of the columns or rows you’d like 
to select.
To select noncontiguous columns or rows: Select 
the first column or row, then hold Ctrl while selecting 
other columns or rows.
To select the entire workbook: Click the 
spreadsheet selector button  (located just above 
the row 1 heading button) or hit Ctrl+A.

How to Enter and Edit Data in a Cell
To enter data in a cell, select the cell and type in the data 
you wish to display. To move to another cell after entering 
data, press Enter, Tab, or an arrow key, or select another 
cell with your mouse.

How to Edit Data in a Cell
To edit data that’s already been entered in a cell, select 
the cell and then either double-click the cell or click in the 
formula bar (see The Excel 2007 Interface).

AutoComplete
Whenever the text you enter in a cell matches text previ-
ously typed into another cell in the same column, an 
Excel feature called AutoComplete pops up a tiny window 
containing the text that Excel thinks you may want to enter 
in the cell:

If the AutoComplete text is what you want to enter in 
the cell, hit Enter.
If the text you want to enter does not match the 
suggested text, just keep typing—the AutoComplete 
suggestion will disappear. 

How to Delete Cell Contents
To delete the contents of a cell, select the cell (or range of 
cells) and press the Delete key on the keyboard. 

How to Cut, Copy, and Paste Data
To cut or copy data from one cell and paste it into an-
other,  select the cell you’d like to cut or paste, then use the  
appropriate keyboard shortcuts or Ribbon icons.

Command Icon Location Shortcut

Cut Home > Clipboard Ctrl+X

Copy Home > Clipboard Ctrl+C

Paste Home > Clipboard Ctrl+V

You can cut or copy multiple cells at once by selecting a 
range and then hitting the icon or keyboard shortcut. To 
paste a range, either highlight the number of cells in the 
range or select the cell you’d like to be the top left corner of 
the range after you paste it. Then paste.

How to Cut or Copy Some of the Text in a Cell
If you want to cut or copy only some of the contents of a 
cell, double-click the cell or click in the formula bar, and 
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highlight the text by clicking and dragging with the mouse 
or by holding Shift+Arrow Key. Then use the keyboard short-
cuts or Ribbon icons to cut or copy.

The Clipboard
The clipboard allows you to cut 
or copy multiple items and then 
select which items to paste. To 
open the clipboard, click on the 
launcher at Home > Clipboard. 
Once opened, every time you cut 
or copy content, that content will 
appear in the clipboard. Click on 
the content in the clipboard to 
paste it into the active cell.
 If you like using the clipboard, 
you can use the options menu at 
the bottom of the clipboard window to set it so it opens 
automatically when you start Excel.

How to Use Undo, Redo, and Repeat
The Undo command allows you to reverse the last action 
you took in your workbook, while Redo will restore the ac-
tion you just undid.

Command Icon Location Shortcut

Undo Quick Access 
Toolbar

Ctrl+Z

Redo Quick Access 
Toolbar

Ctrl+Y

Excel keeps a history of your most recent actions, allowing 
you to undo a series of changes. To access this history, 
click the down arrow next to the Undo icon, then select the  
actions you want to undo. You can redo a series of actions 
in the same way. Note that when you undo or redo an  
action using the down arrow, you also undo or redo all of the 
actions taken after that action.

Repeat
If you haven’t undone any actions, a Repeat icon  takes 
the place of the Redo icon. Clicking the icon or hitting Ctrl+Y 
repeats the last action you performed.

How to Find and Replace in Excel
Excel 2007 lets you search for text or specific formatting 
within your workbook and to replace it with other text or 
formatting using the Find and Replace dialog box. To open 
the dialog box, click the Find and Select icon  at Home > 
Editing or hit Ctrl+F. To search for a term, just enter the term 
in the Find What field and click Find Next or Find All. The for-
mer will highlight the next cell that contains the term, while 
the latter will generate a list of all instances of the term. 
 You can refine your search further by clicking on the 
More Options button, which will give you access to com-
mands that allow you to specify a format or case to search 
for, look only for cells whose entire contents match your 
search term, or choose to search a single spreadsheet or 
an entire workbook.

Excel Formulas and Functions
Excel lets you perform calculations in order to analyze and 
work with the data in an Excel spreadsheet. You can per-
form calculations in two basic ways: 

Simple formulas: Use only addition, subtraction, 
multiplication, or division to work with data.
Functions: Use powerful mathematical formulas built 
into Excel to perform higher-level calculations.

How to Write Simple Formulas in Excel
You can write simple formulas to evaluate a complete 
mathematical expression within a single cell or build an  
expression that relates the data contained in multiple cells.

•
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MAX: Identifies the largest number in a range of cells

To use a function, you must first type an = sign into the cell, 
then type the function’s name (such as SUM or AVERAGE), 
and then enter the arguments—the cells or range of cells 
on which the function should operate. The arguments are 
always contained within parentheses.

How to Insert a Function
If you know a particular function, you can type it right into 
a cell. If you’re less familiar with a function (or functions in 
general) you’re probably better off inserting functions using 
the Insert Function icon  at Formula > Function Library. 
Clicking the icon opens the Insert Function dialog box.

The Insert Function dialog box allows you to search for a 
function by category (recently used, financial, logical, and 
so on) or by typing in a description. The dialog box also 
displays the correct format for writing the function you’ve 
currently selected. Once you’ve found the function that you 
want to use, do the following:

Click OK on the dialog box to insert the function into 
your spreadsheet. (Make sure to select the cell where 
you’d like the function to appear before you open the 
dialog box.)
The Function Arguments dialog box will open. This 
dialog box provides fields listed as Number 1, Number 
2, and so on, into which you can enter the numbers or 
cells upon which you want to perform the function. You 
can enter either a single cell or a range of cells into one 
of these fields. To enter a cell or range of cells, type 
in the correct address, or, with your cursor still in the 
dialog box field, select a cell or range of cells on the 
spreadsheet with your mouse. 
To make the selection process easier, you can click 
the Minimize button  to minimize the dialog box so 
that only the field in which you’re entering numbers is 
visible. You can bring the entire dialog box back into 
view by clicking the Maximize button .
When you’ve entered all the arguments on which you 
want the function to operate, click OK.

How to Use the AutoSum Feature
The AutoSum icon  engages an Excel feature that makes 
it easier to insert a function into a spreadsheet. When you 
use AutoSum, Excel automatically selects the range of cells 
on which to operate. 

If the selection is correct: Press Enter to insert the 
function. 
If the selection is incorrect: Edit the range in the 
formula bar or in the cell itself. 

Despite its name, you can use AutoSum to insert many 
different functions—not just the SUM function. By default, 
AutoSum is set to calculate the SUM of a range of cells, 
but you can change the function that AutoSum applies by  
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How to Write a Simple Formula in a Single Cell
Writing a simple formula that does not reference the data 
in other cells is similar to using a calculator. You type in a 
mathematical expression, and Excel calculates the answer.

Select the cell where you’d like the answer to appear.
Type the = sign. (All formulas in Excel must begin with 
an = sign.)
Type in a mathematical equation using + (plus), - 
(minus), * (multiplied by), / (divided by), or ^ (to the 
nth power) and parentheses to mark the order of 
operations, as necessary. For instance, you could write 
out the expression =(10+5)*3.
Press Enter. The cell will show the answer to the 
mathematical expression (45 for the above example). 
To edit the mathematical expression, select the cell 
and click in the formula bar or double-click in the cell.

How to Write Simple Formulas Involving Multiple Cells
The real power of Excel is that it allows you to write math-
ematical expressions that refer to the data in other cells. 

Select the cell in which you’d like the answer to appear.
Type the = sign to start the formula.
Click the cell that contains the first number upon which 
you want to perform the calculation, or write the cell’s 
address.
Type an operation (+, –, *, /, ^) or a parentheses to 
define the order of operations.

Click the cell that contains the second number that 
figures into the formula.

Repeat steps 4–5 (if needed) until you’ve included all 
the cells you need into the formula.

Press Enter.

How to Use Functions in Excel
Functions are predefined mathematical formulas built into 
Excel. Each function allows you to perform a specific opera-
tion. Excel contains over 300 functions, ranging from basic 
functions to complex functions used in statistics. Some of 
the most popular Excel functions include:

SUM: Calculates the sum of a range of cells
AVERAGE: Calculates the average of a range of cells
COUNT: Counts the number of cells in a range that 
contain a number
COUNTA: Counts the number of cells in a range that 
contain either text or a number
MIN: Identifies the smallest number in a range of cells
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clicking on the down arrow beneath the icon. From the 
menu that pops up, you can then choose AVERAGE, COUNT, 
MIN, MAX, or More Functions.

How to Use Excel’s Fill Feature
Filling is a copying feature that’s unique to Excel. When you 
fill a formula from one cell to other cells, Excel automatically 
increments the formula, modifying the formula relative to 
its destination. For instance, if the cell A3 contained the 
formula =A1+A2, filling that formula to B3 would create the 
formula =B1+B2. In this way, the Fill feature allows you to 
insert a formula or function once, but apply it to a range of 
rows or columns.

How to Fill a Formula
Select the cell that contains the formula.
With your mouse, point to the fill handle, the small 
square at the bottom right corner of the active cell.
Drag the pointer to cover the destination cells, then 
release.

How to Fill a Formula Without Incrementing
For some formulas, you may not want certain cells refer-
enced in the formula to increment when you fill. You can 
control how a particular cell is referenced in a formula by 
using a $ sign. Placing the dollar sign before the letter in a 
reference will stop that reference from incrementing across 
columns, whereas placing it before the number will stop the 
cell reference from incrementing across rows. For instance, 
if the cell A3 contained the formula =$A$1+A2, filling that 
formula to B3 would create the formula =$A$1+B2. The first 
cell would not increment due to the dollar signs.

How to Fill Dates
The fill feature automatically increments dates, months, or 
days of the week. For instance, if a cell contains the date 
8/25/07, filling the cell below it will result in a date of 8/26/07. 
To increment the fill by days, you can just drag the fill handle 
of the cell with the first date to cover the destination cells. 
If you right-click on the fill handle and then drag, when you 
release a pop-up menu will appear in which you can choose 
whether to increment by days, months, or years.

How to Fill Formatting
You can also use the fill feature to copy a cell’s formatting 
(font, cell alignment, cell background color, and so on) to 
adjacent cells:

Select the cell with the format that you’d like to copy.
Right-click the cell’s fill handle, then drag it over the 
destination cells.
When you release, choose Formatting from the menu 
that appears.

How to Sort Data in Excel
You can sort the data in your spreadsheet columns numeri-
cally or alphabetically based on the data in one or more of 
those columns. For instance, if you’ve created a spread-
sheet that records employees’ last names, salaries, and 
start dates, you could then sort all of those columns based 
on the data in one or more of the columns. In other words, 
you could sort the data alphabetically by last name, in order 
of seniority, or from highest to lowest salary.

How to Sort By One Column
Sort a spreadsheet of data according to the data in one 
column by doing the following:

Select all of the data on the spreadsheet. 
Go to Home > Editing, and click Sort & Filter . In 
the menu that appears, select Custom Sort.
The Sort dialog box will open.
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In the Sort By drop-down menu, choose the column 
by which you want to sort the data. If you’ve written a 
descriptive header at the top of your column of data, 
make sure that the “My data has headers” check box at 
the top right of the window is checked and select the 
column based on its header. If your columns don’t have 
headers, make sure the check box is unchecked and 
select the column based on its letter label.
The Sort On drop-down menu lets you specify the 
information you’d like to use from the column as the 
basis for sorting. The drop-down menu lets you sort 
by values (the text or data in the cell), cell color, font 
color, or cell icon. 
Choose an order from the Order drop-down list. A to Z 
means ascending, and Z to A means descending.
Click OK and all the data will sort based on the data in 
the column you selected.

How to Sort By Multiple Columns
To refine a sort, sort by multiple columns. Open the Sort dia-
log box and fill out the first column to sort by, just as you’d 
do when sorting by one column. Then, for each additional 
column you’d like to use to sort the data, click Add Level. A 
new set of drop-down menus will appear; make selections 
from these menus to choose the second column to sort by. 
Note that each column selected takes precedence over the 
next. So if you sorted by salary and then by start date, the 
start-date sorting would come into play only if two employ-
ees had the same salary.

How to Format Cells in Excel
You can improve the presentation of the information in a 
spreadsheet by setting the way text and numbers are for-
matted in each cell. You can set different cell-formatting for 
different cells. To format text already in a cell, select the text 
within the cell and then apply the formatting. To format text 
before you type it, select the cells where the text will go and 
apply formatting before you add the text.

How to Format Text and Cells
The commands at Home > Font on the Ribbon provide basic 
formatting options for text. They also allow you to define the 
borders and colors of a cell or range of cells.

Text Formatting Commands

Command Icon Shortcut

Font Ctrl+D, Arrow Keys, Enter

Font size Ctrl+Shift+P, Arrow Keys, 
Enter

Increase 
font size

Ctrl+Shift+> 

Decrease 
font size

Ctrl+Shift+<

Bold Ctrl+B

Italic Ctrl+I

Underline Ctrl+U (underline) 
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Cell Border and Colors
Icons at Home > Font also let you set the border , 
background color , or font color  for a cell or 
range of cells. Clicking directly on these icons applies the 
current color or border configuration. If you want to change 
the color or border, click on the arrow next to the icon—a 
menu pops up that lets you choose a specific color or which 
edges of a cell or range of cells should get a border. Select 
the option you want and it will automatically apply to the 
active cell or range of cells.

How to Format Cell Alignment
You can format how text is aligned within a cell using the 
commands at Home > Alignment. 

Command Icon Description

Align top Aligns text or numbers at the 
top of the cell

Align 
middle

Aligns text or numbers in the 
middle of the cell

Align 
bottom

Aligns text or numbers at the 
bottom of the cell

Text 
orientation

Orients the text or numbers in 
a cell—vertically, horizontally, 
or at an angle in between

Left justify Justifies the text or numbers 
against the left edge of the cell 
(Ctrl+L)

Center Centers the text or numbers in 
the cell (Ctrl+C)

Right 
justify

Justifies the text or numbers 
on the right edge of the cell 
(Ctrl+R)

Decrease 
indent

Decreases the indent of the 
contents in the cell by one 
character each time you click it 
(Ctrl+Shift+M)

Increase 
indent

Indents the contents of the cell 
by one character each time 
you click it (Ctrl+M)

Wrap Text If a cell contains more text than 
its size can display, Excel hides 
the additional text by default. 
To show the text, you have 
to widen the size of the cell. 
Wrap text changes this setting, 
wrapping text to a new line and 
increasing the height of the cell 
so all text is displayed.

Merge & 
Center

Merges two or more selected 
and adjacent cells, and centers 
any content within the new 
larger cell

How to Format Numbers
The Number group on the Home tab makes it easy to format 
the numbers in your spreadsheets. Along with a drop-down 
menu  that lets you apply the major Excel 
number formats to the active cell, the Number group pro-
vides various number formatting tools:

Command Icon Description

Currency 
style

Applies a currency style with 
a dollar sign before the num-
ber, two decimal places, and 
parentheses around negative 
numbers. The arrow next to 
the dollar sign opens a menu 
that provides more options 
for formatting currency.

Percent 
style

Applies a percent style that 
has no decimal places. For 
instance, if you applied this 
style to 0.17, Excel would  
display it as 17%.

Comma 
style

Places commas to delineate 
thousands, with two decimal 
places and parentheses 
around negative numbers

Increase 
decimal

Adds a decimal place to the 
number shown in the cell

Decrease 
decimal

Removes a decimal place 
from the number shown in 
the cell

Excel automatically rounds a number to however many 
decimals you have formatted it to have. For example, a 
cell that held the number 4.55 when formatted to have two 
decimals would hold 4.6 when formatted for one decimal, 
and just 5 when formatted to have no decimals.

How to Copy Formats
To copy formatting from one cell to another, first select one 
or more cells that contain the formatting you want. Next, 
click the Format Painter icon  in Home > Clipboard. 
Click in the cell or drag over the cells you’d like to format.

Live Preview
Excel 2007 has a new feature called Live Preview, which, 
when you put your cursor over the options on any format-
ting drop-down menu, displays how a formatting change 
will look. If you like how it looks, choose the option by 
clicking it.

How to Format Excel Spreadsheets
In addition to formatting individual cells or cell ranges, you 
can also format Excel spreadsheets in a variety of ways.

How to Adjust Column Width or Row Height
You can adjust the width of a column or height of a row 
either automatically or manually. 

Automatically: Adjusting the column width or row 
height automatically resizes the column or row to 
the smallest possible width or height that can still 
accommodate the cell with the largest data entry in 
that row or column. To do this, point your cursor at the 
right edge of the column heading or bottom of the row 
heading and double-click.
Manually: Adjusting the column width or row height 
manually takes more time, but gives you more control. 
To adjust a column or row manually, click at either edge 
of the column heading or row heading, then drag to the 
size you want.

If you see a cell filled with # signs, it means that the number 
is too long to fit in the column. Once you’ve increased the 
column width enough to accommodate the number, the 
number will appear. 

How to Insert Cells, Columns, or Rows 
You can add an additional cell, a range of cells, or entire 
columns or rows to your spreadsheet. 

How to Add Cells or Ranges of Cells
To add a single cell or a range of cells to your spreadsheet, 
first select a cell or range where you’d like to insert the new 
cell or range. Then either right-click the selected cell(s) and 
choose Insert, or click the drop-down arrow beneath the 
Insert icon  at Home > Cells. 
 An Insert dialog box will open; it gives you the choice to 
make room for the new cells by shifting cells either to the 
right or down. Make your selection, then click OK.

•

•
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How to Add Rows or Columns
You can add a row or column by following the same steps 
you’d use to add a cell or range, but selecting Entire row or 
Entire column from the dialog box before clicking OK.
 Alternatively, you can select a column or row by clicking 
on its heading, then right-clicking and choosing Insert. Excel 
will automatically insert a column to the left of the column 
you selected, or a row above the row you selected. To insert 
multiple columns or rows, select the number of columns or 
rows you’d like to insert, then right-click and choose Insert.

How to Delete Cells, Columns, or Rows
You can delete cells, cell ranges, or entire columns or rows 
in the same way you inserted them: right-click the selected 
cells and choose Delete, or click the drop-down arrow  
beneath the Delete icon  at Home > Cells.

How to Hide and Unhide Columns or Rows
You can hide columns or rows that you don’t want to ap-
pear on a spreadsheet. A hidden column will not appear 
onscreen or when you print. The easiest way to hide a row 
or column is to select a column and right-click, and then 
choose Hide.
 To unhide a hidden column or row, select the rows that 
surround the hidden row, right-click, and choose Unhide. 
To find the columns or rows that surround the hidden  
column or row, look for nonsequential labeling. For in-
stance, if you’ve hidden column C, then columns B and D 
will be adjacent to each other.

How to Add Charts or Graphics to 
Excel Spreadsheets
In addition to presenting data numerically, Excel makes it 
easy to display data visually with charts and graphics.

How to Create Charts in Excel
To create a chart in Excel 2007, follow these steps:

Select the cells you want to turn into a chart. Make 
sure to select both the text (used as labels) and 
numbers (used as data points).
Go to Insert > Charts on the Ribbon. 

Select the type of chart you’d like—column, line, pie, 
bar, area, scatter, or other. Clicking the launcher on 
the group will pop up a menu that lets you look at all of 
your options in more detail.
Whichever type you choose, a drop-down menu will 
appear, offering you specific style options for that type 
of chart. Select the style you prefer.

When you make your selection, the chart will immediately 
appear in your spreadsheet (it may appear over your data, 
which isn’t a problem since you can easily move the chart).

How to Move or Resize a Chart 
To move a chart: Click and hold in the center of the 
chart, then drag the chart where you want it to go on 
the spreadsheet.
To resize a chart: Click the chart, then bring the 
mouse pointer above one of the little squares, called 
selection handles, located at the chart’s corners. Click 
and drag the selection handles to resize the chart.

How to Edit or Format a Chart
When you click on a chart, a contextual tab, called Chart 
Tools, appears on the Ribbon. This tab has three subtabs—
Design, Layout, and Format—that contain commands that 
help you make the look chart exactly how you want it. 

1.

2.

3.

4.
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Design: The Design tab provides tools that let you 
adjust the data range used to create the chart, change 
the chart type you’ve selected, change the style of the 
chart you’ve selected, or move the chart to another 
spreadsheet. 
Layout: The Layout tab lets you edit the particular 
elements of a chart, such as its title, axes, legend, and 
background.
Format: The Format tab lets you change the look of 
the different elements in the table. Select the particular 
element by clicking it, then click the button you’d like to 
use in the Format tab.

How to Insert Graphics in Excel
In addition to charts, 
Excel allows you to in-
sert a variety of other 
graphical elements into 
a spreadsheet by using 
the Insert > Illustra-
tions group. The four main types of graphical elements that 
you can insert are: 

Picture: Digital images or scanned photos 
Clip art: Over 15,000 clip art illustrations
Shapes: A gallery of predrawn shapes, from lines to 
solids to arrows and beyond
SmartArt: Predesigned combinations of words and 
art that allow you to create more complex graphical 
elements, such as flowcharts or org charts

Clicking any of these icons pops up an associated dialog box 
that you can use to select and insert the graphical element 
of your choice.

How to Print Excel Spreadsheets
The print commands in Excel are accessible through the  
Office button menu. The Office button menu contains three 
options: Print, Quick Print, and Print Preview.

Print
Choosing the Print command in the Office button menu (or 
clicking Ctrl+P) opens the Print dialog box. This option pro-
vides you with the most control or flexibility, as the dialog 
box allows you to:

Specify the printer (if you have more than one)
Print all or just part of a spreadsheet
Print all the spreadsheets in a workbook
Set a number of copies
Set the resolution size

Quick Print
Quick Print lets you print a document with one click. But 
Quick Print doesn’t offer any flexibility—it will always print 
one copy of your entire spreadsheet. You can access Quick 
Print through the Office button menu, but it’s faster to add 
Quick Print to the Quick Access Toolbar: 

Click on the arrow at the right edge of the toolbar.
Select Quick Print. 
A printer icon  will appear in the toolbar.

Print Preview
Print Preview allows you to see in advance what your docu-
ment will look like when it prints. It’s particularly important 
to use Print Preview before printing in Excel, because many 
spreadsheets are wider than a typical printed page, result-
ing in awkward page breaks that make it difficult to read the 
data in the spreadsheet. To open Print Preview:

Go to the Office button menu.
Select Print, then select Print Preview.
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If your spreadsheet looks the way you want it to in Print  
Preview, you can print by clicking the printer icon or exiting 
Print Preview and printing in the normal way.

How to Format a Spreadsheet for Printing
If your spreadsheet doesn’t look the way you want it to in 
Print Preview, there are a number of ways to fix the format-
ting of the spreadsheet using the commands at Page Layout 
> Page Setup on the Ribbon.

Command Icon Description

Margins Lets you modify the margins 
of the page, perhaps squeez-
ing in a data column that 
would otherwise get cut off

Orientation Allows you to flip the printed 
page between portrait 
(8.5"×11") and landscape 
(11"×8.5") to best fit your 
spreadsheet

Size Lets you set the page size 
or specify how many pages 
should fit on a single sheet 
of paper

Print area Allows you to specify a cer-
tain area of the spreadsheet 
to be printed. If you’ve set 
a print area, that’s what will 
print no matter what you do 
in the Print dialog box. 

Breaks Lets you set page breaks so 
that you—rather than Excel’s 
default settings—decide 
where the breaks in your 
spreadsheet should occur

Background Lets you add a background 
image to a spreadsheet

Print titles Opens a dialog box that lets 
you specify certain rows 
that should print at the top 
of every page as title rows. 
This is especially useful if 
your columns of data are 
more than a page long, since 
someone reading the printed 
spreadsheet won’t have to 
keep flipping to the first page 
to remember what the data in 
each row represents.

Page Break Preview
In addition to the Breaks button, there’s another way to 
set the breaks in an Excel spreadsheet to ensure that your 
columns of data break where you want them to—the Page 
Break Preview feature. To open this view, click on the Page 
Break Preview icon  at View > Workbook Views.
 This view shows the default page breaks established by 
Excel as dark dotted lines on your spreadsheet. You can 
change these page breaks by clicking and dragging the page 
break lines to a new location.

How to Print Gridlines and Column and Row Headings
By default, Excel doesn’t print the 
gray gridlines or the letter or num-
ber headings for columns or rows 
that appear onscreen in spread-
sheets. However, you can set Excel 
to print gridlines and/or column 
and row headings using the check boxes at Page Layout 
> Sheet Options. If you want the gridlines or headings to 
print, just click the Print box for each. If you wish, you can 
also use the check boxes to stop the gridlines or headings 
from appearing in print or onscreen.


